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Introduction

Cisco Configuration Assistant (CCA), part of the Cisco Smart Business
Communications System (SBCS) portfolio of products, simplifies the tasks of
configuring, deploying, and administering Cisco network solutions, improves the
security and performance of your network, and reduces the time needed for
network deployment and configuration. Designed for small business networks
from 8 to more than 100 users, this PC-based application with a Graphical User
Interface (GUI) provides everything you need to set up a small office network.

New Features in CCA 3.2.3

CCA 3.2.3 is a maintenance release for quality improvement and comprises of the
following enhancements to the user interface:

—Users and Phones Export

—Extension Mobility Feature Ring and SIP support
—Simple form to configure Incoming Dial Plans
—Search Menu

See “Limitations and Restrictions, page 18” for important information that
applies to CCA release 3.2.3.

System Requirements

The system requirements are described in these sections:
Installation Requirements, page 2

Managed Device Support, page 5

Installation Requirements

The PC on which Cisco Configuration Assistant is installed must meet these
minimum requirements.
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NOTE System requirements for processor, memory, display resolution, and disk
space have been increased.

System Requirements

Operating
Systems
Supported
(Windows)

Microsoft Windows Vista® Ultimate (32-bit or 64-bit
edition).

Microsoft Windows XP® Professional, Service Pack 2 or
later.

Microsoft Windows 7® (64-bit and 32-bit).

You must have write permission to your home directory and
to the CCA installation directory; so that CCA can create
the necessary log files and preference files.

For PCs running Windows Vista and Windows 7,
Administrator privileges are required in order to update,
install, and use CCA.

NOTE When using CCA on PCs running Microsoft
Windows 7, set the auto sleep function to Never. To change
the PC’s setting follow these steps:

Go to Control Panel > Power Options.
By default, it is set to Balanced.

Click Change when computer sleeps

Increase “Put computer to sleep” from 5 minutes
(default) to Never

Mac OS Support
(requires
virtualization
software)

Mac OS: 10.5 and later

Virtual OS: Parallels Desktop 3.1 and later or VMware
Fusion 1.0 and later

Guest OS: Microsoft Windows XP (Service Pack 2 or later),
Microsoft Windows Vista Ultimate. CCA also supports
remote control via Virtual Network Computing (VNC)
clients.

Hardware

PC with FastEthernet or higher LAN port

Processor

1.8 GHz Intel Core 2 Duo or higher
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System Requirements

Disk Space 400 MB recommended

Memory At least 2 GB for Windows 7, Windows XP, and Windows
Vista.

Display Screen resolution: 1280 x 1024 or higher recommended

Browser Microsoft Internet Explorer 8.0 or later is recommended,

with Javascript enabled.

The Adobe® Flash® Player 10 or later plug-in for Microsoft
Internet Explorer must also be installed (in addition to any
other version of the Flash plug-in that you may have
installed for different Web browsers).

Javascript must be enabled for the Microsoft Internet
Explorer browser.
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Managed Device Support

CCA manages the following phones, switches, routers, access points, wireless
LAN controllers, and IP video cameras.

Table1 Managed Device Support

Device Type Models

Cisco UC500 | UC520 Platform
Series

Platform UC520-8U-4FX0O-K9

UC520W-8U-4FX0O-K9
UC520-8U-2BRI-K9
UC520W-8U-2BRI-K9
UC520-16U-4FX0O-K9
UC520W-16U-4FX0O-K9
UC520-16U-2BRI-K9
UC520W-16U-2BRI-K9
UC520-24U-8FX0O-K9
UC520-24U-4BRI-K9
UC520-32U-8FX0-K9
UC520-32U-4BRI-K9
UC520-48U-12FX0O-K9
UC520-48U-6BRI-K9
UC520-48U-T/E/F-K9
UC520-48U-T/E/B-K9

UC540 Series Platform

UC540W-FXO-K9
UC540W-BRI-K9

UC560 Series Platform

UC560-FXO-K9
UC560-BRI-K9
UC560-T1E1-K9
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Table1 Managed Device Support

Device Type Models

Modules and VIC-4FXS/DID

Interface VIC2-2BRI-NT/TE

Cards VIC2-2FXO
VIC2-4FXO
VIC2-FXS

VIC3-2FXS/DID
VIC3-4FXS/DID
VWIC2-1MFT-T1/E1
VWIC2-2MFT-T1/E1
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Table1 Managed Device Support

Device Type Models

Phones Cisco Model 6900 Series IP phones:

6961
6941
6921

6911 (NOTE: Video unsupported)
6901 (NOTE: Video unsupported)

NOTE Model 6945 is not supported.

7940G
7960G
7975G
7971G-GE
7970G
7965G
7962G
7961G
7961G-GE
7945G
7942G
7941G
7941G-GE
7937G
7931G
7911G

8961
9951
9971

Cisco Unified IP Phones 7900 Series, following models:

Cisco Unified IP Phone 8900/9900, following models:
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Table1 Managed Device Support

Device Type

Models

Phones
(continued)

Cisco SPA 500 Series IP Phones, following models:

SPA525G2 5-Line
SPA525G 5-Line

SPA514G 4-Line

SPA512G 1-Line

SPA509G 12-Line
SPA508G 8-Line

SPA504G 4-Line

SPA502G 1-Line

SPA501G Basic 8-Line
SPA500S Expansion Module

Cisco SPA 300 Series IP Phones, following models:

SPA301
SPA303

Cisco CP-521/524 phones
Cisco IP Communicator

Cisco Jabber for iPhone
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Table1 Managed Device Support

Device Type Models

Switches Catalyst Express 520 switches, all models
Cisco ESW500 Series switches, all models

ESW-520-8P 8-Port FastEthernet Switch with PoE
ESW-540-8P 8-Port Gigabit Ethernet Switch with PoE

ESW 520-24, 24-Port 10/100, non-PoE
ESW 520-24P, 24-Port 10/100, PoE
ESW 520-48, 48-Port 10/100, non-PoE
ESW 520-48P, 48-Port 10/100, PoE

ESW 540-24, 24-Port 10/100/1000, non-PoE
ESW 540-24P, 24-Port 10/100/1000, PoE
ESW-540-48, 48-Port 10/100/1000, non-PoE

SG200-18 (SLM2016T, SG 200-18, SG200-18), non-PoE
SG200-26 (SLM2024T, SG 200-26, SG200-26), non-PoE
SG200-26P (SLM2024PT,SG 200-26F, SG200-26P), PoE
SG200-50P (SLM2048PT, SG 200-50PF, SG200-50P), PoE
SG200-50 (SLM2048T, SG 200-50, SG200-50), non-PoE

SF200-24 (SLM224GT, SF 200-24, SF200-24), non-PoE
SF200-24P (SLM224PT, SF 200-24P, SF200-24P), PoE
SF200-48 (SLM248GT, SF 200-48, SF200-48), non-PoE
SF200-48P (SLM248PT, SF 200-48P, SF200-48P), PoE

SG300-10 (SRW2008-K9, SG 300-10, SG300-10), non-PoE
SG300-10MP (SRW2008MP-K9, SG 300-10MP, SG300-10MP),
PoE

SG300-10P (SRW2008P-K9, SG 300-10P, SG300-10P), PoE
SG300-20 (SRW2016-K9, SG 300-20, SG300-20), non-PoE
SG300-28 (SRW2024-K9, SG 300-28,SG300-28), non-PoE
SG300-28P (SRW2024P-K9, SG 300-28P, SG300-28P), PoE
SG300-52 (SRW2048-K9, SG 300-52,SG300-52), non-PoE

SF300-08 (SRW208-K9, SF 300-08,SF300-08), non-PoE
SF302-08 (SRW208G-K9, SF 302-08,SF302-08), non-PoE
SF302-08MP (SRW208MP-K9,SF 302-08MP,SF302-08MP),
PoE
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Table1 Managed Device Support

Device Type

Models

Switches
(continued)

SF302-08P (SRW208P-K9, SF 302-08P, SF302-08P), PoE
SF300-24 (SRW224G4-K9,SF 300-24,SF300-24), non-PoE
SF300-24P (SRW224G4P-K9, SF 300-24P, SF300-24P), PoE
SF300-48 (SRW248G4-K9, SF 300-48, SF300-48), non-PoE
SF300-48P (SRW248G4P-K9, SF 300-48P,SF300-48P), PoE

NOTE: SG200-08 and SG200-08P switches are not
supported.

Routers

Cisco Unified Communications 500 Series platform, all models

Cisco SA500 Series Security Appliances, all models (SA520,
SA520W, and SA540)

Cisco Services Ready Platform SRP500 Series, all models,
discovery and cross-launch of native Web-based
Configuration Utility only.

Cisco 800 Series Routers: Models 831, 836, 851, 851W, 857,
857W,871,871W, 876,876W, 877, 877M, 877W, 878, and
878W

Access
Points

Cisco Small Business Pro AP54 1N Dual-band Single-radio
Access Points

Cisco 521 Wireless Express Controller-Based Access Points

Cisco 521 Wireless Express Autonomous Access Points

Wireless LAN
Controllers

Cisco 526 Wireless Express Mobility Controllers

Video
Cameras

Cisco Model WVC2300 and PVC2300 Business Internet Video
Cameras

10

Release Notes for Cisco Configuration Assistant 3.2.3



Release Notes

Downloading and Installing Cisco Configuration Assistant

NOTE

STEP 1

STEP 2

STEP 3

STEP 4

STEP 5

STEP 6

Itisrecommended to use SSL VPN Anyconnect client package version 2.5 only due
to memory constraints. Installing any other recent versions which are not
compatible with UC5xx products will cause the devices to run out of memory and
fail.

To install CCA on your PC, follow these steps:

Go to www.cisco.com/go/configassist. You must be a registered Cisco.com user,
but you need no other access privileges.

In the Support information box, click the Download Software link.

If you are not already logged in, you are redirected to the Cisco.com log in page.
Enter your Cisco.com username and password to log in.

Locate the CCA installer file, for example:
cisco-config-assistant-win-k9-3_2 2-en.exe

Download the CCA installer and run it. You can run the installer directly from the
web if your browser offers this choice. CCA is free; there is no charge to
download, install, or use it.

When you run the installer, follow the on-screen instructions. On the final page click
Finish to complete the installation.

Available and Deferred CCA Versions

The following CCA releases are available for download from Cisco.com:
CCA3.23
CCA3.22
CCA 3.21
CCA 3.2
CCA 3.1
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All other versions of CCA are deferred and are no longer available on Cisco.com.

Updating Cisco Configuration Assistant

STEP 1

STEP 2

STEP 3

STEP 4

Cisco strongly recommends that you upgrade your CCA to the latest version in
order to take advantage of new features and resolved issues.

You can use the automated Application Updates feature to update Cisco
Configuration Assistant to a later release in the language that you are using. Follow
these steps:

Start Cisco Configuration Assistant.
Choose System > Application Updates.

In the Authentication window, enter your Cisco.com username and password and
click OK.

In the Application Updates window, click Yes.

NOTE Cisco Configuration Assistant 2.x installations cannot be updated to
version 3.0 and later using the Application Update process. You must download
Cisco Configuration Assistant from Cisco.com (www.cisco.com/go/configassist)
and install it manually.

Cisco UC500 Software Packs

Cisco UC500 Software Packs are large zip files that contain all necessary files for
the Cisco UC500 Series platform. Each zip file contains multiple TAR/archive files
for the components of the UC500, including:

I0S image for the UC500 platform

IP Phone firmware files

Voice mail software

Factory default configurations for each SKU

Support files, such as Basic ACD prompts and scripts, ringtones, and
desktop images

12
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Separate UC500 software package files are provided for the Model UC520,
UC540, and UC560 platforms. You must download the correct .zip file for your
UC500 platform (UC520_8.6.2.zip, UC540_8.6.2.zip, or UC560_8.6.2.zip).

Cisco UC500 Locale Packs

UC500 Locale Packs contain the software needed to localize voicemail and
phones (locales for Cisco Model 79xx, SPA525, SPA5 1x, SPA50x, and CP-52x
phones).

This means that you only need to download one file to localize voice mail and all
supported phone models.

A locale pack can be provided when installing software on the UC500 via CCA in
order to install an alternate language on the UC500. Up to two languages can be
installed, an active language and an alternate language.

UC500_8.6.2_locale_da_DK.zip (Danish)
UC500_8.6.2_locale_de_DE.zip (German)
UC500_8.6.2_locale_en_GB.zip (UK English)
UC500_8.6.2_locale_en_US.zip (US English)
UC500_8.6.2_locale_es_ES.zip (European Spanish)
UC500_8.6.2_locale_es_MX.zip (Mexican Spanish)
UC500_8.6.2_locale_fr_FR.zip (European French)
UC500_8.6.2_locale_fr_CA.zip (Canadian French)
UC500_8.6.2_locale_it_IT.zip (Italian)
UC500_8.6.2_locale_nl_NL.zip (Dutch)
UC500_8.6.2_locale_no_NO.zip (Norwegian)
UC500_8.6.2_locale_pt_PT.zip (Portuguese)
UC500_8.6.2_locale_sv_SE.zip (Swedish)

Downloading Cisco UC500 Software and Locale Packs

To download Cisco UC500 Software Packs, go to the following URL:
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www.cisco.com/go/uc500swpk

IP phone localization files and voice mail localization files are also available from
this URL. A Cisco.com login is required.

Available Software Packs

These UC500 software packs are available for download:

= Table 2, “Cisco UC520 Software Packages,” on page 14

= Table 3, “Cisco UC540 Software Packages,” on page 14

= Table 4, “Cisco UC560 Software Packages,” on page 15

Table 2 Cisco UC520 Software Packages

UC520 Software
Pack Version

Filename

CCA Version
Compatibility

Component/Version Information

8.6.2 for UC520

UC520_8.6.2.zip (US/English)

CCA 3.2.3 and later

Cisco I0S 15.1(4) M6

CUCME 8.6

CUE 8.6.5

B-ACD scripts v4

UC520 factory default configurations

8.2.0 for UC520

UC520_8.2.0.zip (US/English)

CCA 3.0 and later

Cisco I0S 15.1(2) T4

CUCME 8.2

CUE 8.0.3

B-ACD scripts v3.0.0.2

UC520 factory default configurations

Table 3 Cisco UC540 Software Packages

UC 540 Software
Pack Version

Filename

CCA Version
Compatibility

Component/Version Information

8.6.2 for UC540

UC540_8.6.2.zip (US/English)

CCA 3.2.3 and later

Cisco I0S 15.1(4) M6

CUCME 8.6

CUE 8.6.5

B-ACD scripts v4

UC540 factory default configurations

8.2.0 for UC540

UC540_8.2.0.zip (US/English)

CCA 3.0 and later

Cisco I0S 15.1(2) T4

CUCME 8.2

CUE 8.0.3

B-ACD scripts v3.0.0.2

UC540 factory default configurations

14
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Table 4 Cisco UC560 Software Packages

UC 560 Software Filename CCA Version Component/Version Information
Pack Version Compatibility
8.6.2 for UC560 UC560_8.6.2.zip (US/English) | CCA 3.2.3 and later Cisco I0S 15.1(4) M6

CUCME 8.6

CUE 8.6.5

B-ACD scripts v4

UC560 factory default configurations
8.2.0 for UC560 UC560_8.2.0.zip (US/English) | CCA 3.0 and later Cisco I0S 15.1(2) T4

CUCME 8.2

CUE 8.0.3

B-ACD scripts v3.0.0.2

UC560 factory default configurations

Table 5 Cisco IP Phone Firmware Loads

IP Phone Firmware Loads

Table 5 lists the firmware releases required for the IP Phones that Cisco

Configuration Assistant manages. This table lists phone firmware loads that are
included with the UC500 software packs and have been validated for use with
CCA. If instructed to install a later version of phone firmware to resolve a support
issue, use the CCA Phone Load Management window or drag-and-drop phone
upgrade feature to install the phone firmware.

This most recent list of phone firmware loads is located at:
https://supportforums.cisco.com/docs/DOC-9827

SPA- SPA-
30X 6921 8961
Software 525G SPA- 7915 7921 7940 6901

Pack SPA- SPA- 51X 7914 7916 7925 7936 7937 7960 79XX 6911 6941 9951

50X 6961 9971

525G2
8.6.2 75.2¢c 75.2¢c 75.2d 5.0.4 104 1.4.1SR1 3.3.21 14.4 8.1.2 911 911 911 92.2
8.6.1 75.2a 75.2b 75.2b 5.0.4 104 1.4.1SR1 3.3.21 14.4 8.12 911 911 911 922
8.6.0 74.9c 74.9c -- 5.04 1.04 1.4.1SR1 3.3.21 14.4 8.1.2 911 911 911 922
8.2.0 74.8 74.8a - 5.0.4 104 1.3.4SR1 3.3.20 134 8.1.2 8548 9.0.2 854 --
8.1.0 74.6 74.6 - 5.0.4 104 1.3.4SR1 3.3.20 134 8.12 8.5.48 9.0.2 854 --
8.05 74.4 74.4 -- 5.04 1.04 1.3.4SR1 3.3.20 134 8.1.2 8.6.3S - - -
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Table 5 Cisco IP Phone Firmware Loads

spa- | SPA-
30X 6921 | 8961
Software | 525G SPA- 7915 | 7921 7940 6901
o o | sPA- | oo | 7o1a | 2212 7021 | 7936 | 7937 | I35 | 7oxx | 2097 | 6941 | 995
50X 6961 | 9971
525G2
8.0.4 744 744 - 504 | 104 | 134SR1 | 3320 | 134 | 812 | 8538 | - - -
803 744 744 - 504 | 104 133 | 8320 | 134 | 812 | 8538 | - - -
802 743 743 - 504 | 104 133 | 3320 | 134 | 812 | 8538 | - - -
8.01 743 743 - 504 | 104 133 | 3320 | 134 | 812 | 8538 | - - -
800 742 742 - 504 | 104 133 | 3320 | 134 | 812 | 8538 | - - -
704 719 | 713c - 503 | 103 | 121/ | 3316 | 132 | 801 | 8428 | - - -
131
713 719 | 713c - 503 | 103 | 121/ | 3316 | 132 | 801 | 8428 | - - -
131

Upgrading the UC500 and Installing Device Software

To upgrade software on the UC500 and other devices using CCA, choose

Maintenance > Software Upgrade.

For instructions on how to upgrade software on Cisco UC500 Series platforms,
see the CCA online help or the Cisco Configuration Assistant (CCA) Smart

Business Communications System Administrator Guide, available on Cisco.com.

Minimum Cisco |IOS Releases and Device Firmware Versions

Table 6 lists the minimum software releases required for the devices that Cisco

Configuration Assistant manages.

Table 6 Minimum Cisco IOS Release or Firmware Required

Device

Minimum Software Release

Cisco Unified Communications 500 Series
Model UC520

15.1(2) T4
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Table 6 Minimum Cisco IOS Release or Firmware Required

Device Minimum Software Release
Cisco Unified Communications 500 Series 15.1(2) T4

Model UC540

Cisco Unified Communications 500 Series 15.1(2) T4

Model UC560

Catalyst Express 500 switch

Cisco 10S 12.2(15)T9

Cisco Catalyst Express 520-8PC switch

Cisco I0S 12.2(35)EX

Cisco Catalyst Express 520-24PC switch 12.2(37)EX
Cisco Catalyst Express 520-24LC switch

Cisco Catalyst Express 520-24TT switch

Cisco Catalyst Express 520G-24TC switch

Cisco 800 Series router 12.4(4)T
Cisco 526 Wireless Express Mobility 42.614
Controller

Cisco 521 Wireless Express Access Point 12.4(10b)JX

Cisco Small Business Pro AP54 1N
Dual-band, Single-radio Access Point

Firmware version 1.8.0

Cisco SR520 Secure Router
(ADSL or Ethernet)

12.4(20)T4 and later

Cisco SR520-T1 Secure Router

SR520-T1 Software Pack

Cisco SA500 Series Security Appliances,
all models (SA520, SA520W, and SA540).

Software Version 1.1.65 or later

IMPORTANT Cisco SA500
Series software versions 1.1.42
and earlier are not supported for
use with CCA.

Use the SA500 Security
Appliance Configuration Utility to
manage the SA500 or upgrade to
version 1.1.65 or later of the
SA500 software.
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Table 6

Minimum Cisco I0S Release or Firmware Required

Device

Minimum Software Release

Cisco Small Business Pro ESW500 Series ESW500 Series 24 - and 48-port
Switches models: Firmware version 2.0.3

ESW500 Series 8-port PoE
models: Firmware version 2.1.1 or
later.

Limitations and Restrictions

These limitations and restrictions apply:

IOS Limitations (when upgrading from pre-8.6.0 software pack)

After upgrading software pack to 8.6.x, or later, the UC500 self-signed
certificate will be corrupt. If you are unable to connect to your UC500
using CCA, try connecting using tab Hostname / IP address after setting
HTTP protocol to “HTTP” in the Advanced Options tab. Then press the
Connect button. In addition, any SPA525 phones that are connected
using SSL VPN will fail to connect. You must regenerate certificates by
going to Configure > Security > SSL VPN and click the “Regenerate
Certificate” button (CSCty07520, CSCtz36465).

Passwords in the current IOS version in sofware pack 8.6.x, or later, use
an encryption method that is not backwards compatible with older IOS
versions. When attempting an IOS downgrade, the username/password
will be reset to factory default of cisco/cisco (CSCtz27359,
CSCtz27359).

CUE Limitations

In rare instances, the voice mail disk usage may increase suddenly
leading to voice mail failure. If you encounter this failure, contact the
Small Business Support Center.

In rare instances, under sustained high call volume for several days, the
voice mail system may restart without warning. If this happens, the voice
mail system will not be available for a few minutes; however, it will come
back online without intervention. Contact the Small Business Support
Center if this occurs.

18
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Cisco phones CP8961 / CP9951 / CP9971

These phones have limited feature support; these are the only features
that are supported:

- Topology View

- Extension Mobility

- Voicemail

- Auto Attendant

- Dial by name

- Blast group

- Dial Plan

- Normal Lines

These phones are not supported with Teleworker nor Multisite
environments.

There is no support for these phones in the Telephony Setup Wizard
(TSW).

Cisco Unified IP Color Expansion Modules (sidecars) are not supported.

Cisco Jabber for iPhone

DTMF tones orginating from Jabber for iPhone are not recognized by
Cisco Unity Express and some SIP service provides. To fix this issue, log
in to the UC500 using SSH/Telnet and enter the command:

dtmf-relay rtp-nte sip-kpml

under the voice register pool for Cisco Jabber. (CSCts87199).

The feature set of this application is limited when used with the UC500.
A shared line cannot be created between Cisco Jabber and a desk
phone.

This application has limited feature support;These are the only features
that are supported:

- Voicemail

- Auto Attendant

- Dial by name

- Blast group

- Dial Plan

- Normal Lines

This application is not supported with Telworker or Multisite
environments.
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There is no support for this application in the Telephony Setup Wizard.

For best voice quality, the iPhone should always be associated with the
Voice Wireless LAN SSID. Heavy data usage on the iPhone may cause
voice quality issues on WLAN.

Voice quality is not guaranteed on Cisco Jabber.

For more information on Cisco Jabber, see
https://supportforums.cisco.com/docs/DOC-24508.

SPA8000 / SPA8800

Only one SPA8000 or SPA8800 gateway can be configured and
connected to the UC500.

Only FXS ports are supported for configuration through CCA.

These devices are not supported with Teleworker nor Multisite
environments.

There is no support for these devices in the Telephony Setup Wizard.

For more information on the SPA8000 / SPA8800, see Configuring
SPA8800 / SPA8000 with the Cisco UC500,
https://supportforums.cisco.com/docs/DOC-24912.

Windows 7

Windows 7 provides Network Offload Support, which allows network
adapters to share network tasks with the CPU. One such task is
calculating and assigning checksums before sending packets over the
network. However, some network adapters fail to provide the correct
checksum while files are being transferred during CCA backup, restore,
and upgrade operations. It is recommended to disable checksum
offloading if issues are encountered after all other CCA troubleshooting
steps have been taken, and the network adapter firmware has been
updated to its latest version. On Windows PC, go to Network and
Sharing Center > Change Adapter Settings > Connection > Properties >
Configure > Advanced > Disable TCP Checksum offload (IPv4).
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Notes

The following notes apply to Cisco Configuration Assistant 2.0 and later:

When you start Cisco Configuration Assistant, Java determines whether the
resources it needs are available.

If they are not, Java displays the message Could not create Java
Virtual machine, and the session ends. To overcome this problem, open
the file C:\Program Files\Cisco Systems\CiscoSMB\Cisco Configuration
Assistant\startup\startup.properties (the default installation path), and
modify this entry:

JVM_MAXIMUM_HEAP=1024m
Replace 1024m with 512m.
This problem can occur on PCs with lesser specifications.

If the Cisco Configuration Assistant InstallShield Wizard fails to start, it is
likely there is a problem with the temporary folder location defined through
the environment variables TMP and TEMP. Assign a correct temporary folder
location to fix this problem.

Resolving Cisco Model 79xx Phone Upgrade Issues

After installing a UC500 software pack that contains version 8.5(3) phone firmware
for Cisco Model 79xx IP phones, Model 79xx phones being upgraded from
firmware versions prior to 8.5(2) may not register, or may register but still be
running an older version of the phone firmware. When the phone attempts to
upgrade to 8.5(3), you may see the message “Auth Fail” displayed on the phone.

This is due to a known issue with Model 79xx IP phones (the issue is documented
in the Cisco Unified IP Phone Release Notes for Firmware Release 8.5(3) (SCCP
and SIP (www.cisco.com/en/US/docs/voice_ip_comm/cuipph/firmware/8_5_3/
english/release/notes/7900_853.html#wp57602).

For all SCCP firmware upgrades from firmware release versions earlier than 8.3(3)
to version 8.5(3) or later, you must first upgrade your firmware to version 8.5(2).
Once you have upgraded to version 8.5(2), you can upgrade your IP Phone to
version 8.5(3) or later. The problem affects these CCA-supported phone models:

Model 7975, 7970, and 7971
Models 7945 and 7965
Models 7942 and 7962
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Release Notes

STEP 1

STEP 2

STEP 3

STEP 4

STEP 5

STEP 6

STEP 7

STEP 8

Models 7941 and 7961
Models 7906 and 7911
Model 7931

Perform the procedure in this section to correct the problem by upgrading the
phones to an intermediate load before upgrading them to version 8.5(3) firmware.

Before You Begin—Download the 8.5(2) Phone Firmware

Download the 8.5(2) phone firmware .zip file for each model phone that must be
upgraded. This is the intermediate load that will be used.

IMPORTANT You must download the 8.5(2) version of the phone firmware. The
8.5.2SR1 load cannot be used for this purpose.

To locate the 8.5(2) version of the SCCP (Skinny Client Control Protocol) version of
the firmware for the desired phone models, follow these steps.

Log in to Cisco.com (you must have a Cisco.com login to download phone
firmware).

Open a Web browser and go to www.cisco.com/go/software.

On the Download Software page, choose Voice and Unified Communications >
IP Telephony > IP Phones > Cisco Unified IP Phone 7900 Series > Cisco
Unified IP Phone <79xx>.

Click the Skinny Client Control Protocol (SCCP) Software link.
In the Search Release field, enter 8.5(2) and click Go.
Click the link to the 8.5(2) software.

Download the .zip file for the selected model. For example, the filename for Model
7975 phones is cmterm-7975-sccp.8-5-2.zip.

Repeat these steps to download 8.5(2) firmware for each of the phone models to
be upgraded.

Upgrading the Phone Firmware

Perform these steps to upgrade the affected Model 79xx phones with version
8.5(2) firmware as an intermediate step and then upgrade them to version 8.5(3)
firmware.
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STEP 1

STEP 2

STEP 3

STEP 4

STEP 5

IMPORTANT The embedded TFTP server in CCA is used for drag-and-drop file
uploads. Before performing the upgrade, disable any third-party TFTP services
running on your PC and check the firewall and network security settings on your
PC to make sure that TFTP packets can be transmitted between your PC and the
uC500.

Launch CCA and open the Topology view.

Drag and drop the .zip file with the 8.5(2) phone firmware onto the UC500 icon in
the Topology view.

Do not change the .zip file name or unzip the file.

In the File Upload dialog, click Upload.

CCA extracts the files from the .zip archive and copies them to a temporary
directory on the UC500 flash. If there are any TFTP and load configurations for
8.5(3), these are replaced with the intermediate 8.5(2) load and files.

The Phone Firmware Update dialog shows the progress of the upload. Once the
files are copied to the flash, CCA displays the following message:

“Disconnect all Cisco Model <Model Number> IP phones, and then reconnect
them. Wait until the phone firmware upgrade completes, then click OK to
continue.”

Disconnect and then immediately reconnect the indicated phones. Wait for the
upgrade to complete on all the indicated phones.

IMPORTANT Do not click OK until all of the affected phones have upgraded their
firmware and re-registered. The upgrade takes at least 10 - 11 minutes and the
phones will restart. To verify that the interim load has been installed, press the
settings button on the phone and navigate to Settings > Status > Firmware
Versions > Load File. The interim load filename is SCCP45.8-5.2S.

After the interim upgrade completes, CCA removes the interim 8.5(2) TFTP and
load commands, replaces them with the 8.5(3) TFTP and load commands, and
then issues a reload/reset command to the phones to load the 8.5(3) firmware.
Once the final reload and reset completes, the phones will be upgraded to the
8.5(3) firmware and re-register with the UC500.

Repeat these steps for each different phone firmware .zip file.
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Cisco SBCS Features Supported Within CCA

The Cisco Smart Business Communications System Feature Reference Guide
provides guidance to partners on the features that can be configured using the
latest releases of CCA. The information is categorized by Voice, Switching,
Wireless, and Security.

This guide is available on the Resources tab on the main Cisco Smart Business
Communications product page (www.cisco.com/go/sbcs). From within CCA you
can choose Partner Connection > SBCS Feature Guide to access the guide.

Open Caveats

This section describes the open caveats that could create unexpected activity in
this software release.

Table 7 Open Caveats

Ref Number

Description

CSCsx86872

A DID does not register when Service Provider SIP trunk configuration is loaded from
different PCs.

Symptom Some Day2 additions or modifications under Telephony are misconfigured
for a custom SIP Provider. For example, an added DID may not register correctly. The
custom SIP Provider name is shown in the SIP Provider dropdown list but no Template
information is displayed. The CCA Application log contains this error: ++: ERROR: :
SIPData: SIP Provider read from device is not supported by any template: <PROVIDER
NAME>

Workaround To get around this problem, use only the original CCA installation to
make Telephony related modifications OR add the custom SIP Provider template
(.xml) to all CCA installations which may configure the same UC500.

CSCtn48997

The voice VLAN static route is missing when changing the voice and data VLAN from
the default IP.

Symptom This will happen when an SR520 and UC are not initially configured by the
Telephony Setup Wizard. It will not happen if the Telephony Setup Wizard was used to
configure an SR520 and UC.

Workaround Manually add static route in SR520-t1 to a newly created Voice VLAN
IP network.
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Table 7 Open Caveats

Ref Number Description

CSCtl06532 SIP Trunk: Add configuration to remove second “c” header in SDP.
Symptom Multiple “c” headers are sent in the SDP. This causes issues when the
upstream NAT device sees only NATs on the ¢ header. Service Provider SIP proxy
adheres to RFC3264 and only looks at media level c= line and ignores session level c=
line.
Workaround None.

CSCtk96606 Icon for the 6945 IP Phone is incorrect in the Topology View.
Symptom The icon used for the 6945 IP phone is incorrect in the Topology View.
Workaround None. The Model 6945 IP phone is not supported by CCA. CCA
discovers the phone and displays it in the Topology view, but since itis not a
supported phone, CCA displays the default phone icon in the Topology view.

CSCtk76997 Expansion modules added via the Telephony Setup Wizard do not appear on the Users
and Phones screen.
Symptom The Users and Phones screen does not show phone expansion modules
that were added via the Telephony Setup Wizard.
Workaround None.

CSCtj56444 Program Compatibility Assistant popup appears when installing the CCA on a PC
running Windows 7.
Symptom Program Compatibility Assistant appears after a full CCA installation,
warning the user that the installation might not have installed correctly.
Workaround Choose the option "This program installed correctly” in the Program
Compatibility Assistant popup dialog.

CSCti25821 Anyconnect 2.5 does not work with the SR520-T1 SSL VPN sever.

Symptom An SR520-T1 running SSL-VPN sever with version 2.5 of the Anyconnect
client (anyconnect-win-2.5.02 17-k9.pkg) cannot connect to the SSL VPN server due to a
certification error.

Workaround Use version 2.3 of the Anyconnect client (anyconnect-win-2.3.0254-
k9.pkg).
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Table 7 Open Caveats

Ref Number

Description

CSCtg50723

SIP Trunk: Support individual DIDs for diversion header on SIP trunks.

Symptom When the UC500 is using SIP trunks for PSTN access and there are hairpin
calls (from the PSTN to the UC500, and then back out to the PSTN), the diversion header
for forwarded calls on SIP INVITE from the UC500 only has the main number DID.

Workaround None.

CSCta94933

Need to be able to use a loopback IP address as a source IP for XO SIP Trunk.

Symptom XO SIP trunk requires the ability to specify a source IP address for SIP and
RTP packets on the UC500.

Workaround XO SIP trunk provider will provision the circuit with a source IP
address to be the same as the internet IP address on the XO circuit.
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Table 7 Open Caveats

Ref Number

Description

CSCsz29268

WebEx PhoneConnect: Locale change is not picked up unless the administrator enters
the WebEx PhoneConnect application screen.

Symptom The user changes the CME locale after having configured WebEx
PhoneConnect and the phone does not pick up the new language. This occurs only if the
WebEx PhoneConnect configuration windows in CCA are not accessed after the CME
locale is changed.

Workaround Set the CME locale before configuring the WebEx PhoneConnect
application.

Alternatively, if after setting up the PhoneConnect users and changing the CME locale,
the WebEx PhoneConnect screens on user phones do not have the new language, do
the following:

1. Exit any WebEx PhoneConnect configuration windows that may be open in CCA.
Close any open WebEx PhoneConnect application screens on IP phones.

2. In CCA, go to Applications > Smart Business Applications, select the WebEx
PhoneConnect application, click Setup Options and log into the WebEx
PhoneConnect application. This will open the PhoneConnect Application Main
window and send the CME locale to the PhoneConnect application.

3. Click OK or Apply.

If, after performing the actions listed above, the new language does not appear on the
phones do the following:

1. Exit all WebEx PhoneConnect configuration windows and IP phone screens.
2. Restart CUE from the Maintenance window (Maintenance > Restart/Reset).

3. Wait for the CUE restart to finish.

CSCsx62251

WebEx PhoneConnect: Join before meeting start option is only available to the host, not
the attendee.

Symptom When scheduling a non-audio WebEx Meeting Pro with an option to let
attendees join x minutes before start time, alerts with the Call button x minutes before the
start time are only sent to the host. Alerts for the attendees do not display a Call button
until the meeting start time.

Workaround None.

Release Notes for Cisco Configuration Assistant 3.2.3

27




Release Notes

Table 7 Open Caveats

Ref Number Description

CSCsx20742 | WebEx PhoneConnect: Intermittently phones cannot dial into meeting.
Symptom Intermittently, phone users are unable to have PhoneConnect auto-dial into
the meeting. After the Call button is pressed, the phone remains on the dialing screen,
and no audio is heard.
Workaround To recover, the phone the user must manually end the call. The phone
user can then press the Services button, select WebEx Meetings > Today, click
Details, then either click Call to retry the auto-dial, or manually dial in to the meeting
using the information from the meeting details page.

CSCsx10880 WebEx PhoneConnect: Alternate host and host cannot both join meeting.
Symptom If a user creates a meeting with an alternate host, the host and the alternate
host cannot both join the meeting. The first host to join the meeting is granted host
privileges and the other host cannot join the meeting.
Workaround None.

CSCtr20290 Telephony Setup Wizard: Issues uploading a .wav file in prompt management.
Symptom
1. When uploading a .wav file of 1IMB or less, and not recorded in G.7 11 u-law, an error
message is displayed, but the length of the wave file is retained and shown on the
screen.
2. When a .wav file, of IMB or more is uploaded, it is not accepted. however no error
message is displayed
3. When a .wav file, which is not recorded in g.7 11 u-law and more than 1MB, is uploaded
a no error message is displayed.
Workaround None.

CSCtr19665 Enable-Disable Voice mail resets the Dial-by Name configuration.
Symptom Configure > Telephony > Call Handling > Dial-by Name configuration resets
to none, and does not inform the user.
Workaround None.

CSCtr14585 Smart ports: Maximum hosts field issue in Switch port setup.
Symptom Selected port role is configured on the port.
Workaround Enter a value 1- 10 in the Maximum Hosts field, or leave the default
value if present.
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Table 7 Open Caveats

Ref Number

Description

CSCtr06309

Call accounting to FTP server via CCA fails.
Symptom Enabling call accounting to FTP server fails.

Workaround Manually backup from flash.

CSCtq78188

Changing the installed language does not modify the configuration under CCN trigger
SIP.

Symptom Changing the installed language to another language (that is, Spanish to
Dutch) does not modify the configuration under ccn trigger sip; thus calling to the Dutch
VM pilot number does not play any voice, and the call disconnects after sometime.

Workaround Before changing the installed language perform a factory reset, then
proceed with the locale upgrade or software upgrade.

CSCtq54784

Deleted user still has userid and extension information in mailbox.

Symptom After deleting a user with a mailbox at Telephony > Users and Extensions >
User and Phone > User Extensions Ul, incomplete mailbox information may appear under
Telephony > Users and Extensions > Voicemail > Mailboxes Ul (i.e.,, a userld without the

first name and last name).

Workaround Click refresh in the User and Phones window.

CSCtg55689

Ports > Switch Port Settings > Runtime Status > Device is always Unknown.
Symptom Connected device type is not shown in Runtime Status of Switch Port.

Workaround To view devices connected to the switch, click the "Topology Options"
button in Topology View, then select "Link Interface ID" in the "Show Information" tab.

CSCtq04998

Smart port: Modified port role shows empty when multiple modification is selected.
Symptom This happens only when multiple ports are selected to modify.

Workaround Select single port then click Modify to see the smartport role that is
configured on the port.

CSCtn55711

Changing the subnet of third octet will not change the DHCP range of the IP addresses.

Symptom Changing the subnet mask of third octet will not change the DHCP range of
IP addresses.

Workaround There is no workaround in TSW. Changes can be made in expert
mode.
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Table 7 Open Caveats

Ref Number Description

CSCtn56620 Voice Mail personalized settings are not completely restored from a backup.

Symptom User is prompted for the Voice Mail password and then prompted again to
personalize the Voice Mail settings.

Workaround Add Voice Mail and personalize settings again after password
prompt.

CSCtn39148 Telephony Setup Wizard: Deleting the last digit in the extension field retains the original
value.

Symptom While running Telephony Setup Wizard, and attempting to delete the last
number on FXS, the Voice Mail number filed does not get deleted and returns to the
original pre configured value.

Workaround No workaround in Telephone Setup Wizard. Make the changes in
expert mode.

CSCtn38381 Telephony Setup Wizard: Cannot remove a pre-populated userid.
Symptom Not able to change the Userid.

Workaround None.

CSCtn14032 System uptime for AP54 1Ns always shows zero.
Symptom System uptime in Inventory dialog is always shown as zero.

Workaround No workaround in CCA. Launch Configuration utility of device and
check system uptime.

CSCtl45859 Using CCA to reset to factory default does not restore default Voice Mail language to US
English.

Symptom After resetting to factory default, the VM language is not restored to US
English.

Workaround Reinstall software pack with format flash and then apply the factory
default.
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Table 7 Open Caveats

Ref Number Description

CSCtj67013 A user profile in use should not be deleted.

Symptom The user profile which is in use can be deleted. If deleted the user can be
logged out of the phone and could not login again.

Workaround Login a phone using a user profile. Then delete the user profile from
CCA, EM window.

CSCtw66086 | CCA is not creating the appropriate Access list/NAT with respect to Multisite.
Symptom Enabling firewall after configuring Multisite does not generate proper NAT
mappings.

Workaround Configure Firewall or NAT before configuring Multisite.

CSCtt92348 DIDs for extension numbers associated with SIP Phones are not registered for SIP
Trunk.

Symptom SIP calls to the DID number will fail. The SIP Trunk service provider rejects
the call due to lack of registration.
Workaround None.

CSCty39460 Jabber for iPhone does not recognize IP address when connected to the UC500
through the VPN.

Symptom Jabber for iPhone fails to connect through VPN.
Workaround None.
CSCuc22656 | Broadview SIP Trunk failure.

Symptom Calls to/from SIP Trunk fail.

Workaround For some SIP Trunk deployments using Broadview Networks, the SIP
Trunk settings allowed by CCA when the “Broadview Networks” option is selected
are not complete. Specifically, CCA does not allow configuration of authentication
which is needed in some deployments. For this case, instead of using the Broadview
Networks optionin CCA, create a new custom SIP Trunk Service Provider referencing
all the Broadview Networks Service Provider settings. Custom SIP Trunk Service
Providers always allow configuration of authentication.
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Ref Number Description

CSCuh91523 | UC560 CUE failure on stress testing (with channel loss fix).
Symptom CUE system fails with heavy volume of incoming calls.

Workaround Reload CUE.

CSCuc66910 | UC560 with CUE (8.6.5) “backup category all” command returns “Backup Failed”.
Symptom System returns the message “voicemail backup failed”.

Workaround Execute the “backup category all” command again.

CSCuc91428 | UC560 CUE disk utilization increases disproportionately with usage.

Symptom A bloating of the CUE disk utilzation (DU). This happens disproportionately
with voicemail utilization and continues to grow until a restore is performed from a
backup.

Workaround None.

CSCuh45651 CCA is not able to add a new switch to the network, even if a neighboring device is
detected through CDP.

Symptom CCA handles only the following SKUs for the SG300 28 port switches:

SRW2024-K9
SG 300-28
SG300-28
SRW2024P-K9
SG 300-28P
SG300-28P

Workaround None.

CSCug72036 | Installation of UC500 locale pack fails to complete if the voicemail version does not
match.

Symptom CCA software install for UC500 locale pack takes a long time and never
completes. The UC500 locale pack version does not match the UC500 software pack
version installed; specifically, the Voicemail (CUE) version is different.

Workaround Restart CCA and reload UC500. Install the correct version of UC500
software pack before reinstalling the locale pack, or install the correct version of the
UC500 locale pack for the UC500 software pack already installed.
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Table 7 Open Caveats

Ref Number Description

CSCugb60186 | Afterinstalling UC500 locale pack for 7937 phone, the phone fails to display localized
text even after reloading.
Symptom After successful install of UC500 locale pack, the 7937 phone fails to
download localized files, and the display may be partially localized, even after reloading
the 7937 phone.
Workaround Reload UC500 router and execute the following command to re-
implement workaround to refresh the TFTP binding without the alias command:
(config)#tftp-server flash:/its/user_define_4_rp-sccp.jar

CSCug25383
Symptom Memory Corruption crashes on a Cisco router running 15.1(4)M6 or later.
Workaround Downgrade to 15.1(4)M5.

CSCtw82089 | Software Install fails during restore operation.

Symptom CUE restore returns "generic crypto filter error," and CUE may become
temporarily unresponsive.

Workaround Retry the installation.

Resolved Caveats

This section describes the resolved caveats for the current release.

Table 8 Resolved Caveats

Ref Number Description

CSCue46560 | The 7937 conference phone reloads when the locale is initially configured in CCA.
CSCuf65795 Cisco Jabber on iPhone running version 6.1.2 does not register on UC560.
CSCuf74498 A few mail box entries do not show up after a refresh in fax to mail page.
CSCud23425 | Changing the DHCP Default Router changes the IP address of the interface.
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Table 8 Resolved Caveats

Ref Number

Description

CSCue74214 | IE8 and IE9 need an ability to generate 1024 bit certificates than the default (512 bits) to
connect with SSL VPN.

CSCuf56363 The phone needs an ability to select CHAP/PAP for dialer authentication.

CSCue24048 | CCArrestricts Secondary Destination in SNR for PSTN calls from FXO.

CSCueb8233 | Audio is on low volume for conferenced calls.

CSCtj58651 Switchport association is not modified for new Voice Vlan ID.

CSCue07443 | Need to support Search menu.

CSCue30093 | Monitor status for user and phone extensions needs to be implemented.

CSCue02187 | Need to support Extension Mobility for SIP Phones.

CSCue?29715 | Need to export User Extension Configuration to a file.

CSCual12998 After configuring “no outbound-proxy,” SCCP endpoint to SIP endpoint call is
successful, but fails after a few minutes.

CSCtw66748 | UC560 fails due to corruption while backing up CUE data.

CSCuh40659 | In CCA, the phone region field is not populated on locale install wizard screen.

CSCug71703 | The maximum length of CFNA number sholuld be more than 16 digits for CCA.

CSCuh37705 | Incorrect configuration creates additional trunk group for FXO ports with space.

CSCug76806 | CCA fails to add outgoing dial plan after adding certain limited number of entries to the
dial plan.

CSCub56410 | Inthe SPCP mode, the phone displays wrong characters for the French locale pack
(UC540).

CSCueb62918 | For SPA 50X phones, French characters are displayed incorrectly after version 7.4.8.

CSCuf91421 In SPCP mode, the phone becomes unresponsive while browsing the SETUP menu in
Dutch.

CSCue78248 | In SPCP mode, the incoming FXO calls ring as internal calls for Cisco SPA508/500S
phones.

CSCud36606 | In SPCP mode, the phone loses BLF information.
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Table 8 Resolved Caveats

Ref Number Description

CSCue25835 | Improper provisioning management of HTTP 302 redirect causes the phone to become
unresponsive.

CSCuel7551 The phone reboots while performing a search in Broadsoft Enterprise Directory when
the server is unavailable.

CSCue27856 | The phone becomes unresponsive while performing an LDAP directory search in
Broadsoft Environment.

CSCud25043 | A WebVPN-enabled gateway crashes on Cisco I0OS Release 15.1(4)M5 due to
SSLVPN_PROCESS.

CSCtn08613 Cisco router crashes when interfacing with UCCX.

CSCual12998 | Calls fail between SCCP and SIP phones.

CSCuf56485 CCA configures a short Phase 1 lifetime (1800 seconds) for multisite manager.

Cisco Unified Communications 500 Series Configuration
Support Policy

Information about Cisco Unified Communications 500 Series Configuration
Support Policy is available at:

https://supportforums.cisco.com/docs/DOC-14855

NOTE: Requires partner login to access.

Cisco Small Business Support Community

The Cisco Small Business Support Community site provides resources to assist
VARs and Partners with design, implementation, and maintenance for Cisco SBCS
platforms. To access the Cisco Small Business Support Community, point your
web browser to the following URL:

www.cisco.com/go/smallbizsupport
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Documentation for Cisco Configuration Assistant

The following documentation is provided for Cisco Configuration Assistant:

Cisco Configuration Assistant Smart Business Communications System
Administrator Guide, a comprehensive, end-to-end guide that covers all
features and configuration tasks that can be performed using CCA.

The administration guide is also available in PDF format through the online
help system in CCA.

Online help. To access online help, click the Help button provided in CCA
windows and dialogs, choose Help > Contents from the menubar, or press
F1 to display Help for the active window.

These release notes.

To access documentation for Cisco Configuration Assistant on Cisco.com, visit the
following URL.:

www.cisco.com/en/US/products/ps7287/tsd_products_support_series_home.html

Documentation Addendum

The following items are updates to documentation since version 3.2.1.

The following fields were added to the Configure Telephony > System >
Region page.

- Date Format: Configures the date format on the SIP phones. From the
drop down, select the format that you want to use for the date format.

- Time Format: Configures the time format on the SIP phones. From the
drop down, select the time format that you want to use for the time
format.
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Where to Go From Here

Cisco provides a wide range of resources to help you and your customer obtain
the full benefits of Cisco Configuration Assistant.

Cisco Configuration Assistant

Cisco Configuration Assistant www.cisco.com/go/configassist

Product Page

Cisco Configuration Assistant Technical www.cisco.com/en/US/products/ps7287/
Documentation tsd_products_support_series_home.html

Cisco Small Business

Cisco Partner Central for Small Business www.cisco.com/web/partners/sell/smb
(Partner Login Required)

Cisco Small Business Home www.cisco.com/smb

Cisco Small Business Support

Cisco Small Business Support Community | www.cisco.com/go/smallbizsupport

Cisco Small Business Support and www.cisco.com/go/smallbizhelp
Resources
Phone Support Contacts www.cisco.com/en/US/support/

tsd_cisco_small_business
_support_center_contacts.html

Cisco Small Business Firmware Downloads | www.cisco.com/cisco/software/navigator.html

Cisco Smart Business Communications System and Components

Cisco UC500 software packages and www.cisco.com/go/uc500swpk
localization files
(Cisco.com Login Required)

Cisco Smart Business Communications www.cisco.com/go/sbcsresources
System

Cisco Unified Communications 500 Series | www.cisco.com/go/uc500resources

Cisco Unified Communications 500 Series | www.cisco.com/en/US/partner/prod/collateral/
Configuration Support Policy netmgtsw/ps7256/ps7287/
cisco_cca_cli_support_policy.pdf

(This link requires CCO login)

Cisco SPA500 Series IP Phone www.cisco.com/go/spa500phones

Cisco SPA300 Series IP Phones www.cisco.com/en/US/products/ps10998/
tsd_products_support_series_home.html

Cisco Unified IP Phones 7900 Series www.cisco.com/en/US/products/hw/phones/
ps379/
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http://www.cisco.com/en/US/partner/prod/collateral/netmgtsw/ps7256/ps7287/cisco_cca_cli_support_policy.pdf
http://www.cisco.com/go/spa500phones
http://www.cisco.com/en/US/products/ps10998/tsd_products_support_series_home.html
http://www.cisco.com/en/US/products/hw/phones/ps379/

Release Notes

Cisco AP54 1N Access Point

www.cisco.com/go/ap500resources

Cisco SA500 Security Appliance

www.cisco.com/go/sab500resources

Cisco ESW500 Series Switches

www.cisco.com/go/esw500resources

Cisco Small Business 300 Series Managed
Switches

http://www.cisco.com/cisco/web/solutions/
small_business/products/routers_switches/
300_series_switches/index.html

Cisco 200 Series Smart Switches

http://www.cisco.com/cisco/web/solutions/
small_business/products/routers_switches/
200_series_switches/index.html

Cisco PVC2300 (Audio/PoE) and
WVC2300 (Audio/Wireless-G) Business
Internet Video Cameras

www.cisco.com/go/smallbizcameras

Cisco Secure Router SR500 Series

www.cisco.com/go/sr500

License Notices

Open Source License Notices

www.cisco.com/go/osin

The Open Source Llcense Notice for CCA 3.2.3 is
available on the CCA software download page on
Cisco.com.

Any Internet Protocol (IP) addresses used in this document are not intended to be actual addresses. Any
examples, command display output, and figures included in the document are shown for illustrative purposes
only. Any use of actual IP addresses in illustrative content is unintentional and coincidental.

Cisco and the Cisco logo are trademarks or registered trademarks of Cisco and/or its affiliates in the U.S. and
other countries. To view a list of Cisco trademarks, go to this URL: www.cisco.com/go/trademarks. Third-
party trademarks mentioned are the property of their respective owners. The use of the word partner does
not imply a partnership relationship between Cisco and any other company. (1110R)

© 2013 Cisco Systems, Inc. All rights reserved.
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